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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service-Oriented Computing

• Services encapsulate business logic

• Loosely-coupled, flexible components
• Interface description documents:

1 Functional IOPE interface
⇒ Inputs, Outputs, Preconditions, Effects
⇒ Semantics: associate concepts to IOPE

2 Non-functional Service-Level Agreement
⇒ Contains Quality-of-Service (QoS)
⇒ Specified by the provider
⇒ Example: price, response time, . . .

GlobalWeather service1:

GlobalWeather

City:String

Country:String

Temperature:double

Humidity:double

. . .

asdfasdf︸ ︷︷ ︸
Inputs

asdfasdf︸ ︷︷ ︸
Outputs

1http://www.webservicex.net/globalweather.asmx 1/48

http://www.webservicex.net/globalweather.asmx


1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Services in Practice

• Web services: 20,000 [ZZL10] to 30,000 [Tec12]:

• Successfully applied in many companies, such as eBay,
Amazon [DPPS+08, ZDN12], IBM, DreamWorks,
HP [ZDN12], Winterthur, Deutsche Post [KBS04]

– Credit Suisse [Mur11]: “All applications on the Swiss
Platform offer and/or consume services”
⇒ 1000 services, 400Mio. calls per month.
⇒ Research challenges: existence of 1000s of services,

fault-tolerant design, varying service interfaces

– Twitter API invoked 15 billion times a day, Google and
Facebook 5 billion [LG11]
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Composition

• Key benefit of services: generate new software

– Services are arranged in workflows, described with BPEL
– Executed with BPEL engines → no additional code

necessary (in theory)

⇒ Goal: Automatic service composition

Input
Image
recogn.

Barcode
DB

Amazon
Search

Output

Output

Donald E. Knuth:
The Art of Computer

Programming Volume I

$54.84

5 stars
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Scenario: Mobile Service Store

• User of the system: service broker

• Combines existing services with
his/her own services

• Interesting services: database
access (IP to GPS), changing data
(weather, stocks), data-intensive
(genome alignment)

Steps:

1 Definition of the parameters and
QoS preferences

2 System proposes set of solutions
3 User compares the solutions,

picks one
4 Composite service is registered at

service directory

4/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Composition Approaches

Two main approaches :

1 Planning [WPS+03, KG06, LKS08]

• Starts from scratch
• Applies AI planning tool

– Drawbacks:

⇒ Scalability issues: O(SW ) ( C1 )
⇒ Insufficient coverage of

QoS aspects (Challenge C2 )

2 Selection [ZBD+03, CDPEV05a, YZL07]

• Refines workflow templates
• Faster, QoS-aware: TW , T � S

– Drawbacks :

⇒ No flexibility ⇒ template

required ( C3 )
⇒ Simplified modeling by

Zeng [ZBD+03]: Services in task are

assumed to be equal ( C4 )

Start GoalS
S

S
S

S

S

S

SS
S

SS
S

S S S S

S

Task Task

Task

Task

Task
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Composition Approaches

Both fail to achieve an insufficient

reliability :

• With growing workflow length,
service crashes become more likely

• Most related approaches rely on
ad-hoc replanning during runtime:
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Rel(WF ) =
∏

S∈WF

Rel(S)

⇒ 0.9
10 ≈ 0.35

– Works only if suitable backup services exist
– Might cause additional costs for un-doing certain actions
– No predictability:

⇒ Backup services have worse QoS
⇒ Response time and, potentially, price of the failed

service(s) increase the costs

• Constitutes challenge C5
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Research Theme

• Observation: for a certain purpose (e.g. book hotel
room), multiple services exist

– Developed independently
– Functionally similar but not equivalent

– Näıve integration of planning with selection infeasible

⇒ Requires identical functional interfaces
⇒ Planning has to consider QoS

• Our proposal : integrate planning with selection by

1 Clustering the existing services
2 Planning to create templates, not workflows
3 Selection to refine templates to workflows

⇒ ⇒ ⇒ 1 2

1 2 3

1 2 3

1. 2. 3.

7/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Research Theme

⇒ ⇒ 1 2

1 2 3

1 2 3

1. 3.2.
⇒

• Problems:
– Planning with clusters is “fuzzy”: which clusters can be

combined?
– How to compute templates that contain services with

“promising” QoS?
• Advantages:
⇒ Addresses challenges C2 and C3

– Planning (2.) generates functional template ⇒ flexible (C3)
– Selection (3.) optimizes the QoS ⇒ complex QoS (C2)

⇒ Clustering is basis for tackling the other challenges

⇒ Encodes domain knowledge

⇒ Used in planning & selection
8/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Approach

⇒
Clustering &

Prob. QoS Model

[WIH, Wag10]

Based on:

QoS Model

by Zeng et al.

[ZBD+03]

⇒
Cluster planning

Keikaku

[WIH11b, WIH11a]

Based on:

Reg. planning

e.g. STRIPS

[FN71]

⇒
Customized GAs

Shuuzen,Shuuri

[WIH12, WKIH12]
⇒

1 2

1 2 3

1 2 3

Based on:

Gen. Algorithms

[CDPEV05b]

︸ ︷︷ ︸
Holistic Approach

• Issues in:
– Planning:

C1 Scalability
C2 QoS Aspects

– Selection:

C3 Flexibility
C4 Functional Diversity

– Both:

C5 Reliability

• Addressed by:

– Combining planning and
selection, we address C2 and
C3

– In the following, we focus on:

C1 Scalability
C4 Functional Diversity
C5 Reliability

9/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Assumptions

Assumptions

1 Semantic annotations

– Interfaces annotated
– Otherwise no planning

2 Functionally related

– We know which services can be
combined

– Otherwise no clustering

Our ApproachSel.

PlanningMan.

# Services
per purpose

Diversity

2

4

6

≥ 8
...

⇒

⇑

3 QoS known at any time
– QoS are claimed by the provider
⇒ Violations → penalty mechanisms
⇒ Alternative: (continuous) monitoring or prediction

applied

– Input-independent QoS: backup slides (page 106)

4 Large number of services
– Otherwise scalability not an issue
– Possibilities for optimization phase limited
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → 2. Service Clustering

Cluster planning

Keikaku

[WIH11b, WIH11a]

Based on:

Reg. planning

e.g. STRIPS

[FN71]

⇒
Customized GAs

Shuuzen,Shuuri

[WIH12, WKIH12]
⇒

1 2

1 2 3

1 2 3

Based on:

Gen. Algorithms

[CDPEV05b]

︸ ︷︷ ︸
Holistic Approach

⇒⇒
Clustering &

Prob. QoS Model

[WIH, Wag10]

Based on:

QoS Model

by Zeng et al.

[ZBD+03]



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Comparison with Related Work

• Clustering has been applied to service
discovery [MPG+08]

– Different service comparison, not applicable to
composition

– No additional cached information or QoS model based
on the clustering

• In service composition, only QoS-based clustering
algorithms

– Not applicable to planning

Novelty

– Cluster Representatives

– SEO / Backup Services

– Caching of Service Parameters

– Probabilistic QoS Model

Based On

– Semantic
Matchmaking

– QoS Model
by [ZBD+03]

11/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Clustering - Algorithm

• Services are compared with each other:
– Exact match: same node

S ≡ S′ ⇔ I ≡ I ′ ∧O ≡ O′ ∧ P ⇔ P ∧ E ⇔ E

– Plugin match: edge between the nodes (weaker input
and / or stronger output)

S v S′ ⇔ I w I ′ ∧O v O′ ∧ P ′ ⇒ P ∧ E ⇒ E′

• Results in a directed-acyclic graph
• Connected components become the clusters
• Root nodes become representatives
• Takes around 6 sec. for 10,000 services

Data-int.

{

DB acc.


Dyn. data

{

Name Inputs Outputs
S1 BWImgToBarc. BWImage Barcode
S2 ImageToBarcode Image Barcode
S3 GetProduct Image PID
S4 EUBarcodeDB EANBC PID
S5 BarcodeToPInfo Barcode PID
S6 GetD9Info Barcode PIDD9
S7 Prod.Info. Barcode PIDD14
S8 GetReview PID Review
S9 GetCheapShop GPS,PID GPS, Price
S10 FindLocalShop GPS,PID GPS, Price

⇒ S1

S2

S3

S4

S5

S6 S7

S8

S9,10

C1

C2

C3 C4

C5

12/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Clustering - Execution Orders

• Observation: services can be replaced with services
from the same node and its child nodes (= subcluster):

S4

S5

S6 S7

= Subcluster of S5

• Introduce service execution orders (SEO)

– Determines which service is executed
⇒ Arrange services in fronts, then QoS aggregation

– In case a service crashes, the next service in line is
chosen, e.g. SEO for S5:

S7 S5 S6

– Addresses challenge C5
13/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Functional Parameter Caching

• Apart from backup services, the structure can be used as
background knowledge in planning & optimization

• Helps to avoid unnecessary computations (challenge C1)

S4

S5

S6 S7

EANBC → PID

Barcode → PID

Barcode → PIDD9 Barcode → PIDD14

{Barcode → PIDD9, PIDD14}

{Barcode → PIDD9, PIDD14}

{Barcode → PIDD9} {Barcode → PIDD14}

• Nodes aggregate parameter types of their subcluster
• Supertypes in inputs and subtypes in outputs are

omitted:

Inputs: {EANBC,Barcode} EANBC v Barcode⇒ {Barcode}
Outputs: {PID,PID14} PID w PID14 ⇒ {PID14}

14/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Clustering - QoS Model

• Consequences of backup services: probabilistic QoS

• Goal: predict the values as closely as possible
⇒ Probabilistic QoS model:

– Reliability of a node:

Nrel = 1−
∏

S∈cluster(N)

(1− Srel)

Example:

S5

S6 S7

87%

70% 75%

Nrel = 1−
(

(1− 0.87)︸ ︷︷ ︸
S5 crashes

· (1− 0.7)︸ ︷︷ ︸
S6 crashes

· (1− 0.75)︸ ︷︷ ︸
S7 crashes

)
≈ 99%

• Advantage: build reliable systems with low-cost services
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Clustering - QoS Model

• Introduce for each QoS attribute three values :
1 Best case: first service executed successfully
2 Average case:

E[Nprice] = Sprice
1︸ ︷︷ ︸

Price in case 1

· Srel
1︸︷︷︸

Probability of case 1

+

+
(
Sprice
1 + Sprice

2

)︸ ︷︷ ︸
Price in case 2

·
(
(1− Srel

1 ) · Srel
2

)︸ ︷︷ ︸
Probability of case 2

+

+ . . .

3 Worst case: General idea: all services except for the last
one fail [WKIH12]
⇒ Too pessimistic in reality
⇒ Solution: Apply Tchebysheff’s inequality [WIH]

⇒ In the end, 7 objectives:{(
pbest,E[p], pworst

)
,
(
tbest,E[t], tworst

)
, rel

}
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Service Clustering - Extensions

• Clustering without type concepts [WKIH12]:
– No parameter annotations ⇒ clustering still applicable
– Need relation compatible:

S3

S2

S1

S

S

S ⇒ N2

N1 N3

– Applicable to scenarios with given workflow template
⇒ “Pure” service selection

• Dynamic service environment :

– Efficient insertion of new services
described in [MPG+08]

– Remove service → virtual service

– Services or QoS change: update all
parent nodes:

• Virtual services [WKIH12] . . . (backup slides)
• Physical location [WIH] . . . (backup slides)
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluation

Clustering the OWLS-TC testset2 (≈ 1,000 services):

1 2 3 4 5 6 7 8 9 10≤20 ≤40 ≥ 50
0

10

20

30

40

50
µ = 9.54

Occurrences

C
lu

st
er

si
ze

2http://www.semwebcentral.org/projects/owls-tc 18/48

http://www.semwebcentral.org/projects/owls-tc




1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → 3. Service Planning

Customized GAs

Shuuzen,Shuuri

[WIH12, WKIH12]

1 2

1 2 3

1 2 3

Based on:

Gen. Algorithms

[CDPEV05b]

︸ ︷︷ ︸
Holistic Approach

Clustering &

Prob. QoS Model

[WIH, Wag10]

Based on:

QoS Model

by Zeng et al.

[ZBD+03]

⇒⇒
Cluster planning

Keikaku

[WIH11b, WIH11a]

Based on:

Reg. planning

e.g. STRIPS

[FN71]

⇒ ⇒



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Planning Algorithm

• Planning:
– Given an initial state and goal state, plus a set of actions
– Compose actions to establish a path between these states:

Start Goala1 a2

a3

a4

• Service planning:
– Services and query are translated into PDDL, AI planner

such as SHOP2 [WPS+03] or Xplan [KG06] are applied

– Multiple QoS + constraints → no admissible heuristic
⇒ Scalability issues: In each step, S possibilities → solution

space is O(SW ), W unknown (Challenge C1)
⇒ Insufficient coverage of QoS aspects (Challenge C2)

Novelty

– AI Planning on Cluster Level

– QoS-aware Template Gen.

Based On

– AI Regression
Planning
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Planning Algorithm - QoS Aspects

Challenge QoS Aspects (C2):

• Multiple QoS must be optimized and constraints
must be met

• Domain-independent planner mostly neglect QoS

• Recently, hybrid algorithms have been proposed, such as
QSynth [JZH+10]:

– Won the WS-Challenge in 2009
– Employs simplified QoS model and ignores

constraints

⇒ Used to evaluate our approach in [WIH11b] (next slides)
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Planning Algorithm - Scalability

Challenge Scalability (C1):
• Many functionally similar but not equivalent services

exist
⇒ Search tree grows exponentially :

PID

S3 S4

S1 S2

...

...
...

⇓ adding 2 alternatives per service ⇓
PID

S33S32S31 S41

S11S12S13S21S22S23

S42

S11S12S13S21S22S23

S43

S11S12S13S21S22S23

...
...

...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

• Not addressed by related work in SOC community
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Planning Algorithm - Scalability

Algorithm: Regression planning [GNT04] with services

– Start with given goals

– Adding candidate services:

1

2

3

4

Image
Price

Review

Image PID
Amazon
Search

Price

Review

Image Barcode
Barcode

DB
Amazon
Search

Price

Review

Image
Image
recogn.

Barcode
DB

Amazon
Search

Price

Review

Problem when clusters are used instead of services :
1 When is a cluster applicable?
2 How does adding a cluster modify the set of open goals?
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Planning Algorithm - Scalability

Service planning Cluster planning

• Proposal: cluster planner Keikaku :

– Operates on cluster level instead of service level
– Selects “promising” clusters

– QoS are optimized in the next stage

⇒ Multiple QoS and constraints can be considered

– Consider only representatives in the clusters
– If aggregated parameters in representatives don’t match
⇒ Omit entire cluster
⇒ Avoids unnecessary computations with similar services
⇒ addresses scalability (Challenge C1)

– Else:
⇒ Determine set of matching services in the cluster

(reverse lookup)
⇒ Weakest input constitutes new goal
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Example

Current plan:

GPS

Price

Review

Image

GPS

{Barcode →

Candidate clusters:

S1

S2

S3

S4

S5

S6 S7

S8

S9,10

{Image→ Barcode}

{Image→ PID}

{Barcode →
PID9,PID14}

{PID→ Review}

{GPS,PID→ GPS,Price}
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Example

Current plan:

C3 GPS

Price

Review

S4

S5

S6 S7

{Barcode →
PID9,PID14}

Image

GPS

Candidate clusters:

S1

S2

S3

S4

S5

S6 S7

S8

S9,10

{Image→ Barcode}

{Image→ PID}
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluations - QoS Aspects (C2)

• Used different test sets called T2, T3, . . . , T7 containing
1,000 random services

• In every test set Ti for each service, i similar services are
generated:

• Helps to examine in which scenario the Keikaku
algorithm can be applied (narrow domain, open directory,
. . . )

• Compared with QSynth [JZH+10], winner of the
WS-Challenge 2009

• Added extension of QSynth that can handle backup
services
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluations - QoS Aspects (C2)
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Figure: ut(Keikaku) - ut(QSynth)

• Services are chosen based on a simple heuristic

⇒ No real optimization phase
• Clearly outperforms QSynth, especially when

many services per purpose exist (≥ 3)
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluations - Scalability (C1)

• In the next evaluation, used the test set generator from
the WS-challenge3

• Generated 100 services

• Modified it to generate test sets similar to T2 to T7

• Compared with an exhaustive search planner

• Clusters were refined with a simple hill-climbing
algorithm

⇒ Applying a GA might improve the results

3http://ws-challenge.georgetown.edu/wsc10/ 27/48
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluations - Scalability (C1)
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• Utility is near-optimal

• Runtime of the extensive search is exponential

• Keikaku planner:
leverages the similarity of the services
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → 4. Workflow QoS Optimization

Cluster planning

Keikaku

[WIH11b, WIH11a]

Based on:

Reg. planning

e.g. STRIPS

[FN71]

⇒

︸ ︷︷ ︸
Holistic Approach

⇒
Clustering &

Prob. QoS Model

[WIH, Wag10]

Based on:

QoS Model

by Zeng et al.

[ZBD+03]

Customized GAs

Shuuzen,Shuuri

[WIH12, WKIH12]
⇒

1 2

1 2 3

1 2 3

Based on:

Gen. Algorithms

[CDPEV05b]

⇒



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → QoS-aware Service Selection [ZBD+03]

Start End

T3

S31

S32

S33

T1

S11

S12

S13

T2

S21 S22

QoS Aggregation Rules

$ Rel. Time

Seq.
∑
pi

∏
reli

∑
ti

OR max(pt) min(reli) max(ti)

AND
∑
pi

∏
reli max(ti)

LOOP k · pi relki k · ti

QoS S11

Price 5$

Time 20ms

Rel. 99%

QoS S12

Price 2$

Time 80ms

Rel. 97%

QoS S13

Price 3$

Time 10ms

Rel. 95%

QoS Constraints

Max price 7$

Max time 80ms

Min rel. 90%

Utility Function

µ(Q) =
∑|Q|

i=1wi · Qi

• Goals:
– Utility function is maximized
– All constraints are met

• Very active research field in the past decade, mostly
published on WWW, ICWS, ICSOC, and GECCO 29/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Problem Modeling

Related Optimization Problems (more on backup slides!)
1. Multiconstrained Optimal Path Problem

– Problem: exponential non-dominated paths possible
– Heuristics only of little help [YZL07]

2. Task Scheduling Problem
– Problem: most TSP algorithms apply activity list

representation
– Only few algorithms are efficient, still not

competitive [JMG05]

3. Multidimension multichoice 0-1 Knapsack Problem
– Applied by most related work, covers all aspects
– NP-hard problem, search space: SPTWF , scalability

issues (C1) ⇒ heuristics
– Both, MMKP and selection problem tackled by:
⇒ Integer / Dynamic Programming [ZBD+03, HJHL09]
⇒ Hill-climber [KIH11]
⇒ Genetic Algorithms [CDPEV05b]
⇒ MOO Meta-heuristics [WCSO08]
⇒ . . . 30/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Open Research Problems

Open research problems :
1 Flexibility (C3): Workflow templates required,

unusable if requirements change
– Process template generator described in [LGG+10]:

instead of generating templates from scratch, this generator
retrieves templates from past execution logs

– We employ planning, no past execution logs required

2 Functionally div. services (C4): Related approaches
assume large sets of equivalent services exist [Str10]

– Instead: sparse solution space
– Uninformed meta-heuristics can get stuck in local

optima (next slide)

⇒ Insufficient utility / performance
⇒ Addressed by customized GA

3 Reliability (C5): Addressed by ad-hoc
replanning [LZZ09], neglects impact on QoS

– Alternative: select multiple services per task
– Increases number of input variables

⇒ Insufficient utility / performance
⇒ Addressed by prob. QoS model
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Functionally Diverse Services (C4)

• Related work assumes services are
functionally equivalent

⇒ Services developed independently
⇓

Functionally heterogeneous
⇓

Certain links invalid

• Consequences:

– Local optima more likely, but still
exponential search space

– Meta-heuristics w/o domain knowledge
explore search space randomly

⇒ Slow convergence / low utility

– Simple solution in [LM11]: just modified
the fitness function (compared in eval.)

00.20.40.60.81

0
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0.4

0.6

0.8

1

·105

Service Compatibility

#
of

S
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u
ti

on
s All Solutions

Feasible Solutions

SPT = 10, WF = 5

– Solution space: SPTWF ⇒ SPTWF · pWF

Example: SPT = 10, WF = 50, p=0.5

1050 ⇒ 1050 · 0.550 ≈ 1035 32/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Proposal: Overview

Including Functionally Diverse Services:

• Tackled by: Integrate domain knowledge (=service

clustering) into existing meta-heuristic

– Customize existing single-objective (SOO) and
multi-objective optimization (MOO) genetic algorithms
(GA)
⇒ MOO-GA has best performance in the extended

selection problem out of 15 algorithms
⇒ Easily customizable
⇒ Addresses Challenge C4 (low utility in the context of

functionally diverse services)

– Propose novel genome encoding to cover SEOs
⇒ Addresses Challenge C5 (low reliability)

Novelty

– Genome Encoding of SEOs

– Customized GA Operators

Based On

– GA and their
application to
service selection
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Encoding of a Genome

S25 → S22 → S24

S12 → S13 → S11 S31 → S32

S21

S22 S23

S24 S25 S26

S11

S12 S13

S31

S32

S22 → S23 → S24

S25 → S22 → S24 S23 → S26

S24

Genome: S11

S22
S31

S12 → S13 → S11 S31 → S32

S32S13S12

S25

S26

⇒ {11, 22, 31}

• Each cell encodes a SEO, cached in the cluster nodes.
⇒ One decision variable for up to 3 services
⇒ No increase in the number of input variables

⇒ Preserves utility / performance, fault-tolerant workflow

possible
34/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Customized GA operators

Standard GA

Selection

Crossover

Mutation

SOO: Shuuzen

Selection

Crossover

Mutation

Shuu-Rep.

MOO: Shuuri

Selection

Crossover

Shuu-Mut.

Shuu-Rep.

MOO: Shuuri2

Selection

Shuu-Cross.

Shuu-Mut.

Shuu-Rep.

Based on:
Standard GA

Based on:
NSGA-II

Based on:
NSGA-II

Orig. Op.

Cust. Op.

• Customized operators leverage service clustering :

– Shuu-Repair : Find functionally valid solution (C4)

infeasible solution→ feasible solution

– Shuu-Mutate : Explore feasible solution space (C4)

feasible solution→ feasible solution

– Shuu-Crossover : Max. distrib. of backup services (C5)

• Remark: This presentation covers Shuuri/Shuuri2
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Optimization Phase

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

• Left: For each task, select one service

• Middle: Visualizes the search space, one point = path

• Right: Clustering of task T2, new view
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 1. Mutate operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

• Given solution: {7,1, 1}
• In each generation, mutate operator is applied

⇒ Explore new solutions
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 1. Mutate operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

• Uninformed mutate operator picks task T2

• Selects random service from T2

– 3 of 9 possibilities (33%) invalid!

– Given p = 50%,WF = 3, 1− 0.53 ≈ 97% offspring invalid
37/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 1. Mutate operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

• Shuu-Mutate : given a feasible solution

⇒ With probability Pmut only pick nodes from subcluster
⇒ Explores feasible solution subspace efficiently
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 2. Crossover operator

• Shuu-Crossover : Modified uniform crossover operator

• Genomes are annotated with number of independent
service locations

• Compare the annotations of both parent cells:

– If one parent has more: 75% pick this node
– Else, pick one with 50%

⇒ Favors cluster nodes with distributed services

C1 C2 C3 C4 C5

C1 C2 C′
3 C4 C′

5

C′
1 C′

2 C′
3 C′

4 C′
5

Parent P

Offspring O

Parent P ′

{3}{2}{1}{3}{2}

{2}{2}{1}{3}{3}
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

• Shuu-Repair : Applied with

probability Prep
– Leverage domain knowledge
– By exp.: 33% best trade-off

• Compute target inputs and
outputs by:

Target I : C ∈ O . ∀I . I v C

Target O : C ∈ O . ∀O . C v O

• Intuition : Invalid solutions
“pushed” to feasible solutions,
uses cached parameters

• Applicable for SOO and MOO

• No similarities with repair
extensions of GAs [CB98]

S4

S5

S6 S7

S13

S11

S9

S12

. . .→JPBC

. . .→EANBC

PID→ . . .

PID9→ . . .

S13S11 S4 S9 S12

⇓
S13S11 S5 S9 S12

⇓
S13S11 S6 S9 S12

EANBC→PID

Barcode PID

Barcode→ PID9 Barcode→ PID14

Target I = Barcode Target O = PID9
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

⇒ Start: Invalid solution {9,0, 1} selected
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

⇒ Subcluster 2 pruned ⇒ clustering = search tree
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5
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8 8
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0
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3 4 5 6

7 8 9

⇒ Descend to 1, still invalid
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

⇒ According to clustering, only 3 and 4 are valid
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2
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5 5
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⇒ Randomly select 3
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0
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⇒ Both 7 and 8 are valid

40/48



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Custom ops. - 3. Repair operator

Task T1 Task T2 Task T3

Workflow Level Solution Space Cluster Level

0 0

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

T1

T2 T3

0

1 2

3 4 5 6

7 8 9

⇒ Repaired genome by replacing 0 with 7
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluations - MOO - Settings

• Used the JMetal framework4

• Extended the NSGA-II algorithm ⇒ SHUURI

• Compared it with 15 MOO algorithms (top-5 in the
next slides)

• Generated 20 services for each task, associated with types
from the SUMO ontology5

• QoS randomly generated, except for the price

– In [WIH] we’ve used the QWS dataset6 (backup slides)
– Service reliability from real data
– Moreover, implemented a workflow simulator

• Each test case was evaluated 100 times, max. runtime
5000msec

4http://jmetal.sourceforge.net/
5http://www.ontologyportal.org/
6http://www.uoguelph.ca/~qmahmoud/qws/index.html 41/48
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluations - MOO (C4) - Results
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• Bounds show 90% of evaluation results

• Hypervolume (HV) ratio computed by merging the
fronts of all algorithms

• With increasing problem size (workflow length, low

compatibility) SHUURI outperforms other algorithms
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Evaluations - MOO (C5) - Results
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• Same setting as before, comparing the reliability

• Backup slides: using workflow simulator and simulated
hosts ⇒ physical location
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Holistic Approach

Cluster planning

Keikaku

[WIH11b, WIH11a]

Based on:

Reg. planning

e.g. STRIPS

[FN71]

⇒ ⇒
Clustering &

Prob. QoS Model

[WIH, Wag10]

Based on:

QoS Model

by Zeng et al.

[ZBD+03]

Customized GAs

Shuuzen,Shuuri

[WIH12, WKIH12]
⇒

1 2

1 2 3

1 2 3

Based on:

Gen. Algorithms

[CDPEV05b]

⇒

︸ ︷︷ ︸
Holistic Approach



Start movie of the prototype
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5. Summary



1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Central Contributions 1/2 (repeat)

Issues in existing approaches:

Planning
C1 Scalability

⇒ Many similar services
⇒ Branching factor in

search tree very large ⇒
exponential search space

C2 Complex QoS Aspects

⇒ Optimize multiple QoS,
meet hard QoS
constraints

⇒ No admissible heuristic,
NP-hard

Selection
C3 Flexibility

⇒ User requirements might
change

⇒ Re-computation of
workflow might be necessary

C4 Functional Diversity

⇒ Sparse solution space →
domain-independent
heuristics get stuck in local
optima

⇒ Low utility / slow convergence

Both
C5 Reliability

⇒ Selecting additional backup services for each task increases
number of input variables

⇒ Impact of service crashes on QoS unclear
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Central Contributions 2/2 (repeat)

Planning

Selection

C1 Scalability

C2 QoS Aspects

C3 Flexibility

C4 Func. Div. ServicesC
5
R
e
l
ia
b
il
it
y

m

Keikaku

Shuuri
mutate &

repair

encoding &

crossover

Clustering &
QoS Model

︸ ︷︷ ︸
Challenges

︸ ︷︷ ︸
Contributions

– Extended QoS model and Clustering

⇒ Basis for Keikaku and Shuuri, encodes domain knowledge

⇒ Estimates QoS of service crashes

– Scalable cluster planer: Keikaku

⇒ Avoids unnecessary comparisons of services efficiently

⇒ Computes workflow templates with “promising” QoS

– Customized GA: Shuuri

⇒ Encoding and crossover : efficiently encodes multiple services

with only one variable, maximizes distribution of backup services

⇒ Mutate and repair : fast exploration of feasible solution space,

higher utility, faster convergence
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Assumptions (repeat)

Our ApproachSel.

PlanningMan.

# Services
per purpose

Diversity

2

4

6

≥ 8
...

⇒

⇑

• Requirements:
1 Semantic annotations → Keikaku
2 Func. related services → clustering, Keikaku, Shuuri
3 QoS → Shuuri
4 Large number of services → Shuuri

• Evaluation results: better results with . . .
– . . . growing number of services per purpose
– . . . increasing degree of diversity
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1.In 2.Cl 3.Pl 4.Op 5.Su−→ −→→ → Applicability to other domains

⇒
Clustering &

Prob. QoS Model

[WIH, Wag10]

Based on:

QoS Model

by Zeng et al.

[ZBD+03]

⇒
Cluster planning

Keikaku

[WIH11b, WIH11a]

Based on:

Reg. planning

e.g. STRIPS

[FN71]

⇒
Customized GAs

Shuuzen,Shuuri

[WIH12, WKIH12]
⇒

1 2

1 2 3

1 2 3

Based on:

Gen. Algorithms

[CDPEV05b]

︸ ︷︷ ︸
Holistic Approach

• Functional clustering leverages background knowledge
on the service functionalities

• Characteristics: functionally related entities, arranged in
hierarchy

• Related fields:
– Software components: theoretically applicable; however,

usually only one entity per functionality
⇒ Modified planning problem
⇒ Extended service selection problem (based on MMKP)
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Thank you very much for your kind attention!
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